S

VISON ACTION PLAN

Rolling River S¢hool Division Board of Trustees
2007 - 2008




ROLLING RIVER SCHOOL DIVISION ACTION PLAN

2007 - 2008

1% Progress Report
Approved September 26, 2007

Superintendent’s Annual Report to Rolling River School Division Board of Trustees

Table of Contents

Governance Page 1
Education / Superintendent’s Dept. Pages 2 -3
Student Support Programs Pages 4 -5
Computer Technology Pages 6 -7
Business Administration & Finance Pages 8 -9
Transportation Dept. Pages 10

Maintenance / Facility Operations Pages 11 - 12




ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 - 2008 to 2009 - 2010

Board Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Policy Review » Continue Review of RRSD POliCIeS. ........ovoviiiiiiiiiiieeceee, Ongoing Board
» Review Guidelines for Student Assessment Policy (IKAA).................. 2007-2008
» Review Student Placement Policy (IKE) (Promotion and Retention
1.0 GUIAEIINES) ..
) > Review policy of Ad Hoc and Board Committees..........c..cocceuienennenne.
» Develop policy to deal with appeals to the Board.....................c.ooil.
» Review of Procedural Bylaw and the role of the Chair/Vice Chair........
» Kindergarten entry date reViEW. ... ..ot eeenes
Professional » Board / Admin Workshop........c.ouviiiiiiiiiiie e 2007-2008 Board
2.0 | Development ¢ Board/Sr. Admin discussion before the workshop..................... Oct. 31/07
» Conflict of Interest Workshop for Board Members............cccocoveinnie 2007-2008
Board / CEO P IMplement POlICY. .. ..o 2007-2008 Board
3.0 | Evaluation > Board / CEO Evaluation (Separate night from Board Meeting) Superintendent
8 Planning > Review, discuss and analyze the results of the Parent Survey as it Board Senior
c relates to long range planning ProCess. ........cocvvuviriiiiiiiiiiiiieanenns 2007-2008 Administration
(1] » Deal with declining enrollment / school closures / amalgamation
c 4.0 » Board Legacy
H - » Develop a Board work plan — Annual meeting schedule of all meetings.
Q » Trimester Report (Separate night from Board Meeting)
S Public Promoting » Advertisements in paper Ongoing Board
Relations/ Trusteeship » Info in newsletters
(5 5.0 Communication > Presentations to PAC
) > Info on RRSD Website
» Posters in Schools
Reporting to » Develop a comprehensive plan to report to the community 2007-2008 Board Senior
5.1 Community > Rolling River Education Fund Administration
Enhancing » Education Presentations Ongoing Board Senior
5.2 School-Board » School Tours (set dates with appropriate time between) Administration
Communication
Enhancing » Develop and implement a Communication Protocol for Trustees and 2007-2008 Board Senior
5.3 Trustee Senior Administration Administration
’ Administration
Communication
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

Divisional N -~ Target for Team
Ref. Priority Goal / Initiative Activities Completion Leaders Progress Report
Appropriate Early Literacy > Revised guidelines for DIAL program delivery - Grade 1 2007-2008 S. Furman
1.0 Education Program S. Davar
’ J. Lepp
E. Klassen
Early Numeracy > Implement K-4 Math curriculum changes - Grade Groups 2007-2008 J. McKenzie
- 1.1
(¢} Middle Years Literacy |>» Guided Reading / Writing on-going 2007-2008 T. Radcliffe
() 1.2 > Implementation - Gr. 5-8 Grade Groups (Write Traits Program) B. Sprott
) G. Lawson
2
— Middle Years » Full implementation Gr. 7 Math / Student Engagement and Gr. 2007-2008 J. Hardy
c 1.3 Assessment 8 Reading and Writing as per MECY guidelines L. Jago
((}] : G. Lawson
O K. Burgess
c Social Studies » Implementation of Gr. 5, 7, 8 Grade Group Sessions 2007-2008 J. Hardy
8 1.4 > Grade 6 Implementation 2008-2009
_E Basic French » Final year for Action Plan for Official Languages (AIM Gestures 2007-2008 J. Hardy
= | 1.5 Program) C. Stiles
Q
Q Career Development  |» Implement Gr. 9/10 curriculum 2007-2008 J. Hardy
- » Phase out RRSD School Initiative Course (SIC) for Career Prep 2007-2008
& 1.6 & Exploration 2008-2009
-~ » Implement Gr. 11/12 curriculum
g Vocational Education |» Culinary Arts Program at Erickson Collegiate 2007-2008 J. Hardy
— | 1.7 R. Waterman
njad
© Class Size & » Implementation of appropriate adaptations and accommodation 2007-2010 Divisional Team
g 1.8 Composition Project programming for Gr. 7 & 8 students at Erickson Coll. School Team
©
LLl Healthy Life Styles Physical Education » Develop Division policy for implementation as per MECY 2007-2008 J. Hardy
guidelines — Pilot implementation Gr. 11/12 Phy. Ed. Program J. Potter
20 at MCI
» Implementation of Grade 11 and 12 P. Ed. Program 2008-2009
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

o . N -~ Target for Team
. riori | / Initiativ Activiti . Progress Report
Ref Divisional Priority | Goa tiative ctivities Completion Leaders g p

Professional Growth Behaviour » WEVAS, Restitution and Communicating with Parents 2007-2009 R. Gray
- and Staff Development | Management (Assisted by
o G. McNabb &
Q |30 D. McCallum)
@]
0
e ICT Training » Division Inservices K-12 2007-2008 G. Butler
c M. Dalton
Q
O | 3.1
c
Q
njad
E Declining Enrollment | Distance Education » Implementation of year 1 of 3 years Distance Education Plan 2007-2010 Divisional
1 Committee
8
= | 4.0
/p)
~~
c Safe and Positive Responsible Internet » Cyber bullying awareness programming 2007-2008 J. Hardy
_9 School Environment and Cell Phone use > Divisional video presentation development D. Parrott
-I‘-u' Project » Divisional policy on Cyber Bullying R. Gray
O |50
=
©
Ll
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 - 2010

Divisional Goal / —_ Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Appropriate Update & » develop new policies and make recommendations to the Policy 2007-2008 D. Parrott
Education create new Committee J. Cline
1.0 Programs policies to » revise existing policies where necessary G. Edwards
’ meet
Appropriate
Education Act
Adaptation » review and make changes if NeCeSSary.......oovovviiiiiiiiiiiii e Ongoing D. Parrot
N 1.1 format » transfer to COMPULEr Program......coc.vuiuiiiiiiiie e 2008-2009 G. Butler
E Student » review existing policy/match with Provincial guidelines 2007-2008 D. Parrott
support file » make recommendations to Policy Committee if required R. Gray
E guidelines > inservice Resource teachers, Speech Language Pathologist and Social A. Playter
o)) Worker with guidelines Sr. Adm.
(o) 1.2 » create plan with Resource teacher to review files
- » implement plan to purge/update/review files
(a B » complete file review in each school..............cci 2008-2009
» complete file review in Division Office (psychologist, social worker,
": speech/language pathologist)
(@) Create post » review existing policy/guidelines. ... ..o 2007-2008 D. Parrott
o assessment > create and draft guidelines
o |13 guidelines for | > implement guidelines
-3 Resource D (VA= o] o e == Ongoing
(7)) Teachers
To continue » establish guidelines for Division in area of: 2007-2008 D. Parrott
"E PD and to e behaviour R. Gray
@ develop e instructional/best practices A. Playter
-c 1.4 Divisional e assessment
= guidelines in | » develop plan for inservicing school staff
frr] areas of P inservice staff.... ..., 2008-2009
[dp) Autism
To develop » draft guidelines for working with students affected by Fetal Alcohol 2007-2008 D. Parrott
guidelines for Spectrum Disorder (FASD). R. Gray
and inservice e  behaviour A. Playter
1.5 school staff e instructional/best practices
. about FASD e assessment
» develop plan for inservicing resource teachers and classroom teachers
about working with children affected by FASD
3 INSEIVICE SEAM ...t 2008-2009
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

Divisional Goal / N Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
IEP’s » continue inservicing on writing clear and concise IEPs 2007-2008 D. Parrott
1.6 » plan and implement tracking methods (for classroom teachers) for
outcomes
Adaptations/ > create presentation and accompanying package for classroom 2007-2008 D. Parrott
Modifications / teachers on:
Individualiza- e accommodations
1.7 tion  modification
¢ individualization
n » review with school staff yearly
E Resource » Implementation of Resource Program Review recommendations 2007-2008 D. Parrott
E 1.8 Program J. Hardy
o)) Review
o Implement a » Focus on classroom instruction 2007-2008 D. Parrott
- revised » Define counselling priorities J. Hardy
(a 1.9 Guidance » Inservice administration, staff, students and parents
- Delivery
h Model
(@] Communica- | Inservice » create training opportunities through resource teachers meetings to 2007-2008 D. Parrott
o tion Resource inservice Resource Teachers
o 2.0 Teaqhers on » use case studies / role playing to review / practice running meetings
=5 running
m effective and
efficient
"E meetings
@ Inservice » review role of Resource teachers and update job description as D. Parrott
y o) school staff on NIECESSANY ... et ettt ettt ettt ettt et 2007-2008
] 2 1 role of » create model for resource delivery
i . Resource » create plan for inservicing school staff on role and responsibilities on
w teachers the Resource teacher
» inservice school staff.........coooiiii 2008-2009
Professional | To develop » Explore options of how to increase staff awareness and D. Parrott
Development | skills with understanding of GuUIdanCe role..........oooiuiiiiiiiii 2007-2008 R. Gray
Guidance » Develop a plan (division-wide focus)
3.0 Counsellors » Customize role within each school (Guidance Counsellor &
Administration at each school)
» Inservice staff
» Case studies (to practice sKillS).......veiriiiiiiiiiiiiieieeieceee e, Ongoing
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Appropriate Literacy with > Internet access — changes to the access speeds in all schools 2007-2008 G. Butler
1.0 Education Information > Blended approach to teaching and learning
*¥ | Program Communication Literacy with ICT — High School — 4 more classrooms — 2 at ECI, 1 at
Technology (ICT) RCl and 1 at MCI
Summer » ManACE Workshops offered 2007-2008 M. Dalton
1.1 Workshops ¢ Literacy with Information Communication Technology
’ e Basic Computing Skills
e MS Office
Student > Integrade Pro — all High School staff will be required to use this 2007-2008 G. Butler
. Assessment Markbook Program
a 1.2 > First Class — students accounts will be set-up for all Gr. 9-12 students..

2 Professional Literacy with > New staff will have 2 day training............coooiiiiiii, Aug. 2007 G. Butler
() Development ICT > Divisional Inservice (BATL, Mini BYTE, BYTE) 2007-2008 M. Dalton
c > Blended classroom’s — Principals

- > All K-8 teachers will be issued a division LWICT (Literacy with
O |20 Information Communication Technology) Skill Continuum
Q » BATL (Blended Approach to Teaching & Learning) Workshops for

= School Administration
“ > One-on-One Conferences with Technology Resource Teacher............ 2007-2009

> Full day school WOrkShopsS........ovveieiiii e, 2007-2009

-Ia-lz Communication | Student > Teachers submit work samples............coooiiiiiii 2007-2008 M. Dalton

- Assessment > First Class Connect — outcome based reporting to K-8 students —
Q. running the software in 2 schools — Forrest & Tanner’s Crossing.......... G. Butler
E 3.0 M. Dalton
o > Revision of current report cards to reflect LWICT (Literacy with
o Information Communication Technology).........cocoviiiiiiiiiiiiniinenn 2008-2009 M. Dalton
> All grade 4-8 students create an electronic portfolio..........ccoevinienn... 2008-2009 M. Dalton
Enhance » Inventory program modification and updated..............ccoeevviiiiiiniinnnn 2007-2008 G. Butler
Parent / M. Dalton
Student » All classrooms will have a Web page for students and parents to
COMMUNICALION | GCCESS. .. ettt e et G. Butler
3.1 » Development of on-line Individual Education Plan reporting G. Butler
PPOCEAUIE. ... ..ttt e e e ee e e G. Butler
» Personnel data base update / Human Resources program...................
> Classroom Web Pages - Introduce Blogs for posting homework and M. Dalton
Class “DISCUSSION”. ... . et e ettt e ettt e e e e e e e e e e aeee e 2008-2009
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

Divisional Goal / —_ Target for Team
. - Activiti h Progr Report

Ref Priority Initiative ctivities Completion Leaders ogress Rep
Web Page as a [» Develop and implement a process / protocol for web page 2007-2008 G. Butler
primary maintenance K. McNabb
communication J. Hardy
tool

3.2

Computer Technology
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007- 2008 to 2009 - 2010

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Communication | Financial > Review and revise communication of Financial Statement information 2007-2008 K. McNabb
(Budget & Statement re: implementation of PSAB and Provincial Summary Reporting
1.0 Financial
. Reporting)

Q
(&)
c Implement the » Operation of the Rolling River Education Fund (RREF) .................. 2007-2008 K. McNabb
(1] Rolling River ¢ Implement Committee structure and meetings
c |11 Education Fund  Develop a communication/ promotion strategy
™ (RREF) > Maintain operation of the RREF as per Policy...............cccoceviiennn. Ongoing
06 Provincial Increased » Maintain standards / policy / procedures for school fund / school fund 2007-2008 J. Hardy

Requirement Accountability fundraising (School Funds Manual) and Divisional School Cash Net K. McNabb
c (PSAB - and Accuracy accounting program for school funds (Type A) L. Good
(@) Accountability) » Review and evaluate Audit process for School Funds
— 20 Improved » Develop and implement standard process for financial reporting to
© : School — school communities for school based funds and implement GST
: Community rebate claim procedure for school funds.
7)) Communication | » Implementation of Divisional reporting of School Funds (Type A)
" — (PSAB)
c
- Provincial Compliance » Develop and implement procedures and methodology for compliance K. McNabb
E Requirement with Public with PSAB standards for Division Budget and Financial reporting:
© Sector e First PSAB compliant Budget (2007/2008).........ccccocvivnerinnenenen. 2007-2008
<L |30 SCCO(;Jming e Quarterly PSAB Financial repors. ..................cceeeeeeeeeeeeeeeennne, 2008-2009

oar
2] Standards
3 (PSAB)
c Develop and » Orient and implement new WSH regulations with school Based 2007-2008 K. McNabb
‘7, Implement a Committees
-3 Workplace » Survey to assess WSH training needs — develop opportunities to
m Safety & Health provide WSH training.
3.1 Program > Develop and implement Job Hazard Analysis and Safe Work
Procedures
» Participate in MAST WHAM Software Project
» Participate in WSH related partnerships with other School Divisions
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2006- 2007 to 2009 - 2010

Divisional Goal / N Target for Team
Ref. o e e Activiti . Progress Report
© Priority Initiative ctivities Completion Leaders 9 P

Review , » Define needs and goals of inventory systems 2007-2008 K. McNabb

((b] Evaluate, » Review current systems G. Butler

(&) Revise and » Investigate alternatives L. Dobreen

c Implement » Develop Policy and Regulation

© 3.2 Appropriate > Implement a comprehensive inventory process...........cocovevveienennenns 2008-2009

[ = Assets

e Inventory

LL Systems

Declining Develop Data » Develop a 10 year enrollment forecast and school space implication 2007-2008 K. McNabb

c Enroliment for School (=7 o1 ] o F PSPPSR

o 4.0 Plan Enroliment » Develop long term options for school utilization/consolidation............ 2007-2009

-— ) Forecasts /

e Trends

"‘7; Communication | Efficient and > Develop and implement a divisional records retention policy and 2007-2008 K. McNabb

— o . Coordinated procedures that meets the minimum requirements of Manitoba

c (Administration) | Divisional Education for the retention and disposal of all Division records

r— Policy and (administrative and student).

E 5.0 Process for the

o) . Retention and

<L Destruction of
Records

n

7))

Q Support Staff » Develop and implement a Support Staff Orientation Handbook 2007-2008 K. McNabb

E Orientation (including relevant policy, procedures, payroll, benefits, accounts HR

(7)) 5.1 Handbook etc.)

: .

m
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 — 2008 to 2009 — 2010

Divisional Goal / —_— Target for Team
Ref. o cee Activities . Progress Report
© Priority Initiative Completion Leaders 9 P
Declining Efficient routing » Monitor routes — plan for further reduction in Douglas & Oak River Ongoing D. Tesarowski
1.0 | Enroliment » Consider impacts on Transportation as a part of school utilization/consolidation 2007-2009
options
Safe and Provide training » Bus drivers Job Hazard Analysis training, Hours of service training, WHIMIS D. Tesarowski
Positive to bus drivers training (product they handle)....... ..o e 2007-2008
2.0 | Environment and mechanics > Mechanics school in March...................c. Mar. 2008
"5_ Provide a safe » School bus replacement plan continues..........c.coovviiiiii 2007-2008 D. Tesarowski
@ up to date » Vehicle standards monitor mechanics’ Worki...........coooviiiiiiiiiiiiiiien,
Q 2.1 vehicle > Review to purchase new transportation truck / review tow truck replacement.....
(o) Provide efficient | » Monitor extra-curricular use and budget allocation 2007-2008 D. TesarowskKi
- |22 extra-curricular
: travel for schools
©
wjend
3 Supplies/parts » Make purchases necessary while exercising wise purchases with good value D. TesarowskKi
23 inventory while comparison ShOPPING. .....v e 2007-2008
% . » Continue the use of inventory work order program............cocvvieiiiiiiiinnenennn. 2007-2008
% Healthy Lifestyle | Investigate » Monitor fuel consumption / efficient routing 2007-2008 D. Tesarowski
— (Operating environmentally | » Research alternate fuel
|_ 3.0 Environmentally) | friendly fuel ¢ biodiesel
¢ hydrogen
e propane injection
Provide » Review Douglas fuel tank 2007-2008 D. Tesarowski
approved » Monitor tank condition Division wide
3.1 storage for bulk
fuel within our
Division
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2007 - 2008 to 2009 - 2010

Divisional Goal / —_— Target for Team
Ref. Priority Initiative Activities Completion Leaders Progress Report
Safe & Capital “D” » Onanole Elem. - D.O.C. Controls 2007-2008 L. Dobreen
Positive Projects » Douglas Elem. - Fire Alarm Upgrade Mtce. Staff
Learning » Elton Coll. - P.S. System Contractor
1.0 | Environment > Rivers Coll. - Computer Lab Air Conditioner
(7)) » Tanner’s Crossing - Flooring in 1 classroom and Camera’s
c » Erickson Elem. - Flooring in 1 classroom
(@) » Forrest Elem. - Flooring in 1 classroom
— Playground » Work with in our budget to improve our play structures......................... Ongoing L. Dobreen
] maintenance | » 5 year plan to have this completed
- and » Once completed - maintenance is a priority
O 1.1 repairs » Parent Groups are involved and partners with the Division
(o > Rivers Elem. - Sand and borders around sSwings............cc.cooviuveneennenns 2007-2008 L. Dobreen
O » Tanner’s Crossing - Sand, borders around swings and new tire swing set..
> Summer > Division Office renovations 2007-2008 L. Doreen
- | 1.2 Projects » Erickson Coll. - Grooming Room & new wheelchair ramp
" — ’ » Repair brick wall control joints
O Schools » The painting program is scheduled to complete two schools per year - Ongoing L. Dobreen
L‘E Painting Tanner’s Crossing and Onanole Elem.
1.3 Program » Painting classrooms during school year; hallways and some classrooms 2007-2008 L. Dobreen
—~ ) done during Breaks. ... 2007-2008
((}] » All schools - exterior painting if time permits...........c.coooiiiiiinn.
o
c Garage/ Long Term » Complete a review of Division Office, Maintenance and Garage facilities Senior Admin
o Maintenance/ | Strategy to Report (Operations Committee)........covuieuiuiiiiiiiiii e 2007-2008 Dept. Mgrs &
C 1.4 Division Plan for a » Develop a plan for future utilization/development of the facilities Dept. Staff
((}] " |Office Facility | New Garage
"E Facility
(_U PSFB > Onanole Elem. - Phase | - Roofing & West Brick Wall 2007-2008 L. Dobreen
E Projects » Rivers Coll. Grooming Room K. McNabb
» Rivers Coll. Gym Floor Structural Review
1.5 > Minnedosa Coll. Structural Review
» Huts at Elton Coll.
» Closed Hut at Oak River Elem.
» On going heating replacements and roof replacements
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ROLLING RIVER SCHOOL DIVISION ACTION PLAN - 2006 - 2007 to 2009 - 2010

Divisional Goal / A Target for Team
Ref. Priority | Initiative Activities Completion Leaders Progress Report
Grounds » Continue 5 year plan to repair/upgrade & maintain parking lots in the 2007-2011 L. Dobreen
n Maintenance D17 o T o PP D. Tesarowski
1.6
c
o
e Appropriate | Computer » Upgrade cabling and electrical ability off all schools to support L. Dobreen
© Education wiring in technology needs and plans for 2007-2008 Mtce. Staff
qh, Programming | schools SCROOIS. ...t
o ¢ Additional 1.0 FTE Term Electrician for project
e Upgrades to Forrest, Onanole, Division Office and Tanner’s
O Crossing, Erickson Coll., Elton, Douglas and Rivers Coll.
2.0
3 » Upgrades to Rivers Elem., Oak River, MCI, Rapid City and Erickson
— =1 TP Ongoing
(&)
©
LL
N Professional | Provide » Continue with WSH Training 2007-2008 L. Dobreen
evelopment | training for rrange for P.D. session for Custodial sta
0 Devel ining f > A for P.D ion for Custodial staff
g staff > WHIMS Training
g 3.0 » Continue working on Job Hazard Analysis and Workplace Health Safety
o
c
" — Accountability | Maintenance | > Investigate a Work Order and Inventory Program 2007-2008 L. Dobreen
© Inventory & K. McNabb
= | 4.0 Work Order G. Butler
Program
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